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Installation

Then you will choose either 32-bit and/or 64-bit installation of 
Simplify. Once you have made your selections click ‘Start In-
stallations’. It will go through a  9-part installation process and 
once it is finished you may exit the Topaz Software Manager.

Important for Mac Users
After installation, Simplify 4 will be installed in the following 
folder: “ Applications->Topaz Labs -> Topaz Simplify 4”.

Important for PC Users 
After installation, Simplify 4 will be installed in the following 
folder: “C:\ ->Program Files (x86) ->Topaz Labs -> Applications 
-> 32-bit/64-bit -> Topaz Simplify 4”.

The Topaz Software Manager is the new host for your 
Topaz installations. You will be able to easily access 
your downloads, updates to Topaz Simplify from this 
host.
 
Before you install the  Topaz Software Manager, 
please close all applications, including Photoshop, 
Photoshop Elements, Lightroom, iPhoto, Aperture, 
etc.
 
Please do not open any other applications during the 
installation process. 

 
To Begin Installing the Software Manager 
Double-click on the installation file provided from your 
download from the Topaz Labs website. A window 
will appear displaying the Topaz Software Manager 
setup wizard. 

 
The Installer will walk you through the process.

After you have read the Read Me and accepted the 
End User License Agreement, your installation will be 
completed and you can close the Wizard.

The Software Manager will then launch and you will 
need to click ‘Install Topaz Labs plugin(s) not current-
ly installed on this computer, and then ‘Next’.
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Installation
Lightroom 
To use Simplify 4 in Lightroom you will need to go through 
Topaz Fusion Express. Fusion Express will be automatically 
downloaded with Simplify 4. Fusion Express should automati-
cally be listed as a preset within Lightroom. If you would like 
to use Fusion Express as your external editor, please see the 
setup instructions below.

For Mac:
1) Go to “Lightroom -> Preferences … -> External Editing”, in 
the Additional External Editor panel, choose Fusion Express 
(located in “Applications -> Topaz Labs -> Fusion Express”) as 
the external editor

2) Select TIFF in File Format pull-down menu

3) Select the Color Space choice and Bit Depth. It is recom-
mended to use 16-bit ProPhoto RGB for Color Space for best 
preserving of color details from Lightroom.

For Windows:
Open Lightroom (if you had it open during installation you 
will need to first restart it). Go to your Lightroom menu -> 
Preferences. Navigate to the External Editing section. You 
will need to make several selections here in order to config-
ure Lightroom’s external editing options: 

Under the Additional External Editor section please click on 
the Choose button next to Application. This will bring up a 
finder window allowing you to navigate your system files.

For 32-bit Windows find it here: C: -> Program Files -> Topaz 
Labs -> Applications -> 32-bit->Fusion Express application

For 64-bit Windows find it here: C: -> Program Files (x86) -> 
Topaz Labs -> Applications -> 64-bit -> Fusion Express applica-
tion

Under the file format option please select Tiff
Under the Color Space option please select ProPhotoRGB
Under the Bit Depth option please select 16bits / component

Please see below on how to properly install into Photoshop, 
Photoshop Elements, Lightroom, Aperture, and iPhoto.

Photoshop and Photoshop Elements
When your installer is complete it should automatically install 
in to your Filters tab under Topaz Labs->Simplify 4 . 

If you can’t see Simplify 4 after you quit and restart Photo-
shop, try the following:

For Mac :
Go to Applications -> Topaz Labs -> Topaz Labs Plug-ins -> and 
copy and paste the Topaz_simplify4.plugin file to your Photo-
shop Plug-Ins folder. This is usually located in Applications -> 
Adobe Photoshop -> Plug-Ins. Delete the Simplify 4 shortcut 
already in that folder, if there is one. Restart Photoshop and 
you’ll see it in the Filters menu.

For Windows:
Go to C:\Programs Files (x86) -> Topaz Labs -> Applica-
tions -> 32-bit/64-bit ->  Topaz Plugins -> copy and paste the 
tlsimplify4ps.8bf file into your Photoshop Plug-Ins folder. This 
is usually located in C:\Program Files -> Adobe -> Adobe Photo-
shop -> Plug-Ins. Delete the Simplify 4 shortcut already in that 
folder, if there is one. Restart Photoshop and you’ll see it in 
the Filters menu.
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To use Simplify 4 in Aperture you will need to go 
through Topaz Fusion Express. Fusion Express will be 
automatically downloaded with Simplify 4. Fusion Ex-
press should automatically be listed as a preset within 
Aperture. If you would like to use Fusion Express as 
your external editor, please see the setup instructions 
below.

Aperture user’s have the option of using Fusion Ex-
press as a plug-in (recommended) or as an external 
editor. 

To use Fusion Express as a plug-in to access your 
Topaz filters in Aperture, select an image and go to 
Photos -> Edit with Plug-in and select Topaz Fusion 
Express.

To configure Fusion Express as your external editor in 
Aperture, follow the steps below:

1. Go to: Aperture -> Preferences and select Export. 
Here you will make several selections to configure 
Aperture’s external editing options and to set Simplify 
4 as your default external editor.
2. Click the Choose... button underneath the External 
Image Editor Field and navigate to: Applications-> 
Topaz Labs ->   Fusion Express and select “Open” or 
“Choose”
3. Make sure that the External Editor File Format field is 
set to Tiff.

After configuring Simplify 4 as the additional External 
Editor in Aperture, a menu item called, “Edit in Fusion 
Express”, is added under Apertures “Photo -> Edit In” 
pull-up menu.

Installation
iPhoto 
To use Simplify 4 in Aperture you will need to go 
through Topaz Fusion Express. Fusion Express will be 
automatically downloaded with Simplify 4. Please see 
the setup instructions below for external editor setup 
in iPhoto:

Please see the iPhoto Configuration instructions 
below:

1) Go to iPhoto -> Preferences …-> General
2) Locate the Edit Photos Option and select “In Applica-
tion ...” to launch your finder window.
3) Then you will need to navigate to Applications ->  To-
paz Labs ->Fusion Express and then click Open - this will 
save your selection back to your iPhoto preferences. 
4) Make sure that the box next to “Save edit as 16-bit 
TIFF”.

For information on how to get set up in programs 
like Paint Shop Pro, Irfanview, and/or Serif Photo Plus 
please visit topazlabs.com/setup for step-by-step          
instructions.
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Uninstalling
You will then be taken to this screen where you will 
check the box next to the word ‘Simplify’ and then 
click ‘Start Uninstallation’.

Once it is ‘Finished’ your program will be uninstalled 
completely.

To uninstall Topaz Simplify follow these instructions:

You will need to first open your Topaz Software 
Manager.
 
For Mac it will be located in your Applications->Topaz 
Labs folder 
 
For Windows it will be located in your Start Menu 
under Topaz Software Manager

You will first see the welcome screen. 
Click on the ‘Uninstall Topaz Labs plugin(s)’ option 
and then click ‘Next’.
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About Topaz Simplify

Topaz Simplify opens up the traditional art medium 
by bringing digital photographers the tools needed to 
instantly transform any digital image into a work of art.

Simplify can blur the distinction between photographic 
realism and art, allowing you to make your digital im-
age into something that is truly unique to look at. 

Topaz Simplify allows you to easily apply the look of 
brush strokes and other art tools with ease.  Using 
Simplify, you can enhance the essence of your original 
image giving you a dynamic and creative result. 

Topaz Simplify is also great for rescuing previously 
unusable images.  By adding artistic enhancements to a 
damaged, underexposed, overexposed, dull or boring 
image, you can instantly transform it into something 
that is creative, unique and-eye catching. 

The Primary Functions of Topaz Simplify Include: 

1. Remove details from your image based on size. 

2. Enhance or remove color in images.

3. Generate or reduce lines, edges and shading for 
changes in distinctness. 

4. Fine-tune images to match your artistic vision.

5. Create a new and artistic interpretation of your digi-
tal images with ease and artistic precision.

6. Rescue unusable images by adding a traditional art 
flare.

Introduction

Original Simplify Cartoon Simplify Sketch

Before Topaz Simplify

After Topaz Simplify
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1. Apply Button. Stack multiple effects and presets 
during the same workflow.

2. Local Adjustments. Intuitive selective adjustment 
brush for burning, dodging, smoothing, and brushing 
out (erasing) added adjustments - plus edge-aware 
options.

3. Presets Collections. Presets are organized into 7 
unique collections.

4. My Collection. Users can now save their presets 
under My Collection.

5. Histogram. Shows the tonal range of your image.

6. Curve Tool. Easily adjust image tonality to help 
emphasize tones, contrast and brightness within your 
image.

7. Finishing Touches Tab. Features options for vi-
gnettes, tone adjustments and overall transparency 
adjustment.

8. Split Screen. Use the 2-screen split view for easy 
before and after comparison.

9. Effect enable/disable. Clickable preview options 
that allow you to hide or view a set of adjustments for 
easy comparison.

Introduction

Before Topaz Simplify

After Topaz Simplify
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Work Area

Interface (Main View)
Although the Topaz Simplify interface may look intimidating at first glance, don’t worry: it’s actually quite simple and 
easy to use.  You’ll soon be a pro after experimenting with it for a bit.  In order to make sense of the function of each of 
the various controls, we have divided the interface into a few sections:

1

1. Presets/Effects Preview 5. Settings & Parameters2. Presets Panel 4. Preview Navigator
Displays previews of
presets & effects.

Controls the editing using sliders 
to adjust the various effects.

Provides “snapshots”
 of pre-defined effects.

Displays the region of the
preview image you are 
currently focused on.  Also
displays histogram.

3. Preview Window
Displays the preview of the 
original and adjusted image. 

2

1 3

4

5
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Work Area

Interface (Tool Panel View)
Use the small white arrows to expand and collapse the preset panel.  You can click the white arrow            or grab the 
edge of the panel and drag it in or out.
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Work Area

Interface (No Panel View)
Use the small white arrows to expand and collapse the preset and tool panels.  You can click the white arrows                    
or grab the edge of the panels and drag them in or out.
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Work Area

Interface (Preset Panel View)
Use the small white arrows to expand and collapse the tool panel.  You can click the white arrow                or grab the 
edge of the panel and drag it in or out.
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mouse button on the preview image and drag it 
around.  When you let go of the mouse button, the 
new portion of the image will be processed and the 
result will be displayed. 

Preview Section 
The Preview section is the main window that is cen-
tered in the Simplify interface.  The preview section 
shows you the original image and the processed pre-
view of the image.  Click on the image in the preview 
window (or use the Original and Preview buttons) to 
switch between the Original and Preview tabs and 
compare the filtered and un-filtered images. 

Work Area

You can also use SPACE bar or your numbered shortcut 
keys “1” and “2” to switch back and forth between your 
filtered and unfiltered image in the preview window.

1
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The “Ctrl/Cmd +” and “Ctrl/Cmd –” keys zoom in and 
out of the image, just like in Photoshop.  

You can use the arrow keys to adjust the value of the 
slider that is currently selected.  

A complete list of the shortcut keys can be found in 
the Shortcut Keys section later in this manual.

You can zoom in or out of the preview image by click-
ing the “+”, or “-” buttons below the preview image.
You can also resize the window as well by dragging 
the bottom right corner in and out. 

The “Fit” button will fit the entire image into the pre-
view window. 

The “100%” button will zoom to 100% view. 

If zoomed below 100% the preview image will be inter-
nally resized in order to speed up preview updating.
 

Work Area

Photoshop and other host software support many Image 
Modes, such as Grayscale, RGB, LAB, CMYK, etc.  Images 
can also be 8, 16, or 32 bits per channel.  Topaz Simplify 
supports both 8 bits per channel and 16 bits per chan-
nel.  Topaz Simplify supports RGB mode only.  To work on 
black-and-white images, first convert them to RGB mode.

Visit the Simplify Gallery to see Topaz Simplify at work:
http://gallery.topazlabs.com/keyword/simplify
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Work Area

Presets
Presets are a great way to speed up and simplify the 
whole process of using Topaz Simplify.  Presets are 
set previews with previously defined settings that you 
can recall and reapply at any time. 

We’ve included some default presets for you and, al-
though they won’t work for every single photograph, 
they serve as excellent starting points for customized 
tweaking.  

Applying Presets 
Applying a default preset is easy and intuitive. Simply 
clicking on a preset will change all the settings in To-
paz Simplify to match those in the selected preset. 

To get the exact results you want, you may still want 
to go through the tabs and tweak the parameters.

Adding Presets
Sometimes it’s convenient to be able to define pre-
sets and save your settings for later use.  To do this, 
first adjust the Topaz Simplify parameters until you’re 
satisfied with the result. Then, click on “Save”. 

 
 

1. Presets Preview
The removable preview 
window displays
preset previews.  Click 
Hide / Show to expand or 
collapse the preset pre-
view window at anytime 
during your workflow.

2

3. Presets List
Lists all of the saved pre-
sets available for use. 

2. Effects List
Lists all of the effect col-
lections which contain 
your presets.

4. Preset Options

The preset options 
allow you to save your 
presets, delete presets 
(default presents cannot 
be deleted), import new 
presets and export your 
saved presets to share 
with your friends. Remember that you can easily expand or collapse the presets 

panel by clicking on the small white arrow on the edge of the 
panel or by grabbing the panel edge and dragging it in or out.

3

4

1
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Work Area

Then enter a preset name, select the type of image that 
it is good for and then enter a description and click “OK”.  
You can also select a second image category type that the 
preset is good for. 

Note that if the preset name you’ve entered is the same as 
any currently saved preset, then you will be asked if  you 
want to overwrite the current one. 

Your preset will be automatically saved as a new file with 
a “.tpp” extension in the Topaz Simplify Presets menu and 
the preview is automatically generated.  To apply it later, 
just click it like any other preset. 

Your presets will be saved in the “My Colection” category 
by default.

Deleting Presets
If you’d like to delete a preset select the preset name and 
then click on Delete.  

Please Note: Default presents cannot be overridden or 
deleted.  Once you delete a preset it or overwrite it when 
saving, then it cannot be retrieved.  

Saved presets are located in the Topaz Simplify “Presets” folder:
C: \ Program Files \ Topaz Labs \ Topaz Simplify \ Presets unless 
you’ve opted to install Topaz Simplify into a different directory. 

Mac users have this folder at Applications\Topaz Labs\Simplify 4\
Presets
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Work Area
Exporting Presets
To export the preset file to a certain location, click 
“Export”. 

Name your preset and save it to your desktop or 
other specified location that you have reserved for 
saved presets.

You can then share this preset file with others who 
may then import it. 

Sharing Presets
Feel free to share your saved presets by emailing 
them to your friends and having them put it into their 
Topaz Simplify Presets folder.  

Importing Presets
To import a preset file, click the “Import” button.

This will open up a “Browse” box to import a saved 
preset from your computer into Topaz Simplify.  This 
is useful if you have downloaded a preset file that 
you’d like to use. 

Visit the Topaz Labs Blog which features the latest 
Photography, software and design information including 

tutorials, videos, and thoughts about both Topaz and 
non-Topaz topics.

For more information about Simplify be sure to check 
out the Simplify website at: www.topazlabs.com/simplify
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Work Area

Tools
You will use the various tools in the tool panel during 
your work- flow to make your image adjustments.

1. Preview Navigator/ Histogram tabs. The Navigate 
tab displays the region of the preview image you are 
currently focused on. You can drag the preview navi-
gator box around to pan your image. The Histogram 
tab displays the tonal range of your image.

2. Zoom Buttons. Use the zoom buttons to zoom in 
and out of your image. You can also set your image to 
fit the preview window or to view it at 100%.

3. Undo and Redo buttons. Move back and forward 
through previous adjustments.

4. Snap and Recall buttons. Save up to 99 snapshot 
settings for easy comparison.

5. Sliders and Parameters. Controls the editing pro-
cess using sliders to adjust the various effects.

6. Local Reset. Resets all of the slider values in this 
sub-category back to the default value.

7. Apply. Allows you to stack multiple effects and pre-
sets during the same workflow.

8. Reset All. Resets all of the slider values back to the 
default value.

9. I Feel Lucky! Applies a set of randomized param-
eters.

3

8

2

7

6

4

9

5

1
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You can access Topaz Simplify’s menu by clicking on 
the “Menu…” button at the bottom of the interface. 

Preferences
Offers various options to customize your usage and 
interface preferences. You’ll need to restart Simplify 4 
for your changes to take effect.

Work Area
Enable Tool Tips
Controls the program’s pop up tips that appear when 
you hover over a button or slider.

Enable Auto-Update
Allows Simplify 4 to automatically check for available 
up- dates. (Requires an active internet connection)

Use Topaz Labs Style
Uses the dark grey interface color scheme. Disabling 
this will change the interface color scheme to light 
grey.

Show Presets Preview at Start-up
Disabling this will hide the preset panel when you 
invoke Simplify 4. This will allow the program to load 
faster.

This options is intended for those who mostly work 
with the slider adjustments and do not want to use 
the presets - which take more time to load the pre- 
views.

You can open/close the preset panel at any time 
during your workflow by clicking on the small white 
arrow located on the edge of the interface.

Interactive Sliders
Take advantage of interactive slider/control response 
during your workflow. This feature works best for 
faster systems.
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Contents
Check for Update
Checks for available Topaz Simplify updates. 

When you click ‘Yes’ your Topaz Software Manger will 
launch and you will select the ‘Update Topaz plugin(s) 
currently installed on this computer, and click Next. 
Then you will see this screen to run the update.

Enter Key
Select this to enter your trial or purchased license key. 

What’s This?
Select this (or click F1) then click on a feature in the 
Simplify interface to learn more about it. 

Users Guide
Select it to pull up this user guide.

Tech Support
Brings you to the Topaz Labs support page where you 
can request assistance from our support specialists, 
contact our customer service team, retrieve lost li-
cense keys, or browse through others users questions 
and answers. 

Product Info
Select this to go to the Topaz Simplify web page to 
learn more about the Topaz Simplify plug-in.

Work Area
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Contents

After Topaz Simplify

Gallery
Select this to open up your Internet browser and go 
to the Topaz Simplify image gallery to see other user 
images enhanced with Topaz Simplify.

MyTopaz
Brings you to the Topaz community where you can 
connect and interact with other Topaz users.  Here 
you can also participate in discussions and contests, 
and share your favorite Topaz images. 

Tutorials
Brings you to the Topaz Simplify tutorials page where 
you can access a variety of helpful video and text tu-
torials.  You can also submit tutorials that you created 
here as well.

About
Select this to see what version of Simplify you cur-
rently have.

Work Area

Before Topaz Simplify
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Settings & Parameters 

Effects & Presets
Topaz Simplify has 7 Effect collections with over 100 
presets to help you achieve optimal image results.

Parameters
The adjustment tools in Topaz Simplify allow you to 
manually create effects and/or tweak preset settings to 
customize a unique look for each of your images.

Simplify includes 3 tool tabs with a wide range of 
parameters that will allow you to make endless adjust-
ments and customizations.

These tabs are featured in an easy-to-follow (sug-
gested) workflow order. However, you are welcome to 
work in any order you’d like.

Colorspace allows you to change the space where the 
simplifying action takes place.  The RGB colorspace tends 
to produce more dramatic color effects, while the YCbCr 
colorspace tends to shift color less.
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Simplify has 3 different modes to work in and process 
your image with. 

The “Base” mode reveals only the base tones in your 
image. 

The “Edges” mode reveals only the edges of your im-
age. 

The “Combined” mode reveals the combination of 
both the edges and tone in your image.

Global Adjustments
This tab include basic tools that includes Simplify Mode, 
Simplify, Adjust, Edges, and a new Curve Tool.

Settings & Parameters 

Before Topaz Simplify After Topaz Simplify
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The Simplify tab controls what details in the image

are removed and which ones are retained. Different

combinations of the settings create many different 

possibilities. 

Settings & Parameters
Colorspace
Colorspace allows you to change the space where the
simplifying action takes place. The RGB colorspace 
tends to produce more dramatic color effects, while 
the YCbCr colorspace tends to shift color less.

Simplify Size
Defines the size of the details being simplified. Any de-
tail with a size below this value will be removed, leav-
ing behind only the larger features. The value of this 
parameter is relative to the entire image’s size. 

Feature Boost
Boosts the main features in the image and exaggerates
details. Use this in the RGB color space to introduce col-
orful artifacts into the image. For more natural image
colors, switch the colorspace to YCbCr.

Details Strength
Selectively brings back detail from the “simplified”
image, and controls the strength of these details. This
parameter works with the Details Size slider.

Details Boost
Controls the weaker details in the image. A setting
higher than 1 accentuates weaker details, while a set-
ting below 1 weakens minor image details.

Details Size
Determines the size of image features to be considered
“detail” which will be brought back with the Detail
Strength slider. The value of this parameter is relative
to the full image size. 
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Settings & Parameters

Brightness
Controls the brightness of the image. A value greater
than 0 increases the brightness and a value less than 0
decreases the brightness.

Contrast
Controls the contrast in the image giving you the ability
to increase or decrease the appearance of the darks
and lights in your image proportionally.

Saturation
Increases or decreases the color saturation (richness of
color) in an image.

Saturation Boost
Adjusts the amount of saturation in the weaker image 
colors without affecting the stronger image colors.  
Setting this value higher than 1.0 will make the color 
more vibrant, while a value of less than 1.0 makes the 
weaker color appear more washed out.

Dynamics
Effects the contrast and tonal balance on a local level, 
versus global.

Structure
The amount of detail enhancement applied in the im-
age. A value higher than 1.0 strengthens the details 
in the image while a value less than 1.0 reduces the 
strength of details. 

Remove Small
Removes smaller image details whose size is below
this value.

Remove Weak
Removes weaker image details with a strength below
this value.

Adjust 
The Adjust tab offers convenient color, tone and detail 
controls which allows you to alter the brightness, con-
trast, detail and saturation of the simplified image. 



26

User Manual
To

pa
z 

 S
im

pl
ify

Contents
Structure Boost
The amount of detail enhancement applied to the
smaller details in the image. A value higher than 1.0
strengthens the weaker details in the image while a val-
ue less than 1.0 reduces the strength of smaller details. 
This parameter affects mostly weak details. Strong 
details should be adjusted using the Structure slider.

Edges 
The Edges tab brings out, modifies or alternatively cre-
ates edges in the photo. It also offers the ability to use
those lines alone or to combine them with the rest of
the image (known as the base). While the Simplify and
Adjust tabs make up the main portion of the image, the
Edges tab plays an important role in determining the
size, shape and color of the edges in an image, which
can affect the final result in many ways.

Inverse Color
Enabling this box will inverse the edge color. By 
default, edges are black or colored on a white back-
ground. You can use this feature to create white or 
colored edges on a black background.

Edge Type
Simplify offers 8 different types of edges that you can 
use to accentuate the effect of your image. This in-
cludes different combinations of color, size and style
of edge lines. 

Edge Strength
Increases the strength of the displayed edges.  This fea-
ture only detects edges that have not been excluded 
by the Simplify Edge parameter.

Simplify Edge
This removes image features of a certain size. The
higher this setting is, the less number of edges that will
remain. This parameter is analogous to the Simplify
Size parameter in the Simplify tab.

Reduce Weak
Reduces edges that are faint or weak in intensity. This
feature is ideal when there are stray weak lines around
the edges that you would like to remove.

Reduce Small
Reduces edges that are small in size. This is also ideally
used when there are small lines around important edge
detail that you wish to remove.

Settings & Parameters
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Contents
Fatten Edge
Fattens the image edges, making them thicker. This
feature is useful when the original image edges are thin
or too small.

Curve Tool 
The curve tool allows you to click and drag to add/ 
move points, controlling image contrast, brightness 
and tone. It also includes some default curve presets 
for quick application.

Reset
Resets the curve back to the default values.

Curves (drop down menu)
Pre-loaded curves

You can access the histogram from the Curves tab located
in the Global Adjustmetns tab or you can use the quick

access one that shares space with your preview navigator

Settings & Parameters
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Contents

Local Adjustments
This tab allows you to selectively apply image adjust- 
ments using an intuitive brush. Adjustments include 
burning, dodging smoothing and erasing/brushing out 
applied adjustments.

Adjustment Type
Choose Dodge, Burn, Brush Out or Smooth. Note that 
the slider options below the adjustment type will ap- 
ply to whatever adjustment type you have selected.

Dodge
Used to lighten (dodge) specific areas of your image by 
increasing the exposure in those areas.

Burn
Used to darken (burn) specific areas of your image by 
limiting the exposure in those areas.

Brush Out
Allows you to easily taper down the strength of ef- 
fects or remove them completely. The Opacity slider 
controls how opaque your adjustments become. The 
higher the value the more effect that will be removed.

Smooth
Smoothes out detail using the Smooth option - this is 
great for cleaning up areas of skin and sky.

Overall Strength
Advanced blending control over applied adjustments. If 
dodging or burning is too weak or strong, the strength 
slider allows for further control. Note that the below 
adjustments will apply to whatever type you are in.

Brush Size
Controls the size of the brush.

Settings & Parameters



29

User Manual
To

pa
z 

 S
im

pl
ify

ContentsSettings & Parameters

Finishing Touches
This tab includes useful finishing touches that you can 
apply to your image. It includes transparency, 
vignettes, and toning.

Transparency
Control the overall effect strength by adjusting the 
transparency slider and add as much or as little effect 
as you’d like to your image.

Overall Transparency
Controls the overall strength of your applied (global) 
adjustments to your image. Increasing this parameter 
will made your overall effect more transparent.

Vignette
This effect allows you to add a basic vignette to your 
image.

Center (button)
Click to set the center point for your vignette.

Vignette Strength
Controls how heavily the vignette is applied to your 
image. A higher value will produce a darker vignette, 
whereas a smaller value will produce a lighter, more 
opaque vignette

Vignette Size
Controls the size of the applied vignette. A higher value 
will expand the width of the vignette towards the 
edges of your image. A smaller value will contract the 
vignette inward to the center of your image.
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Vignette Transition
Determines the hardness of the transition between 
the blurred (out-of-focus) background and the focused 
foreground. The higher the value the softer the transi- 
tion will be.

Vignette Curvature
Controls the blend between the vignette and the 
original image. The larger values will produce a longer 
softer transition and the lower values will produce a 
shorter transition.

Tone
Tone allows for 4 different tones to be selected and 
applied to different tonal regions within an image. With 
4 tones, enhanced contrast and detail can be easily 
applied. Selecting one color or 4, advanced toning and 
artistic effects can be applied.

Color Region 1
Click on the corresponding color swatch and a color 
picker will pop-up for a color to be selected. Once the 
color is selected, use the Region 1 slider to select where 
on the tonal scale that color is to be applied.

Color Region 2
Click on the corresponding color swatch and a color 
picker will pop-up for a color to be selected. Once 
the color is selected, use the Region 2 slider to select 
where on the tonal scale that color is to be applied.

Color Region 3
Click on the corresponding color swatch and a color 
picker will pop-up for a color to be selected. Once 
the color is selected, use the Region 3 slider to select 
where on the tonal scale that color is to be applied.

Color Region 4
Click on the corresponding color swatch and a color 
picker will pop-up for a color to be selected. Once 
the color is selected, use the Region 4 slider to select 
where on the tonal scale that color is to be applied.

Tonal Strength
Determines the strength of the tones applied to the 
image.

Hint: Choose all four of your colors first before 
moving the Regions sliders.
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In this section, we will walk you through a sample 
project, step-by-step, to help you become more famil-
iar with the Simplify program.  We will focus on using 
a combination of presets and manual adjustments.

Workflow
We will be using this waterfall image for our example.  
The goal for this image is to take it in a more artistic 
painting direction by removing some of the smaller 
details and lines and enhancing the color.  In the 
following steps, we will show you how to achieve 
optimal results with your own photos, following this 
model. So, let’s get started.

1. Open an image file. 

2. Create a duplicate layer of your image.  Right-click 
on your image layer in your layers and select “Dupli-
cate Layer”. You can also achieve this by selecting 
your image layer and dragging it down to the new 
layer icon. 

Before Topaz Simplify

After Topaz Simplify
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Workflow
Again, we want to take this image into a more artistic 
direction by removing details and giving it a painterly 
effect.  Doing this will bring new character to the 
scene.  To achieve this we will be working with the 
presets and sliders for this example, but you can start 
any way you like.

3. To begin working on your image go to Filters -> 
Topaz Labs -> Simplify 4.

4. Once your image loads,  use the zoom tools to 
zoom in on a specific part of your image.  Then you 
can click on the preview and drag it around until you 
find an area that you like. 
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Workflow

If you are satisfied with the preset adjustments then 
you can click “OK” to process your image and save it 
back to Photoshop. 

If you would like to make some additional adjust-
ments to your enhancement settings, then you can 
do so by adjusting any of the sliders in the three tabs 
manually until you achieve your preferred image 
results. 

5. If you want to choose a default preset, scroll 
through the panel on the left side of the screen. 
To select it, just click on it and the sliders will 
automatically adjust to the pre-defined settings 
and parameters. For this example we will be 
using the BuzSim preset.

Don’t forget that you can use the shortcut keys in 
Topaz Simplify 4 to speed up your workflow.
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Workflow
8. The Adjust tab gives you control over the color, 
contrast and brightness of your image.
  

9. Slowly adjust each of the sliders to perfect the 
color in your image.  For this image we will increase 
the Contrast slider just a bit. 

10. We will also gently increase the Saturation and  
Saturation Boost sliders.

When you are happy with the color settings, move to 
the Edges tab. 

6. Start in the Simplify tab.  It is a good idea to begin 
here, and then progress to the Adjust and Edges tabs 
in order to see the effects of your adjustments easily. 

7. Slowly adjust each of the sliders to create the op-
timal exposure in your image.  For this image we will 
only increase the Simplify Size slider slightly, allowing 
more of the smaller details to be removed. 

When you are happy with the Simplify settings, move 
to the Adjust tab. 

Remember: You can use the Saturation Boost slider’s ability to 
adjust the saturation levels of weaker image colors to create a 
“selective color” effect. 
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Workflow
you are happy with the new artistic look of your image 
then you are ready to process your changes. 

11. Click OK and watch your image transform into a 
beautiful artistic masterpiece. 
 

The Edges tab is where you can really make the objects 
in your image pop by enhancing or minimizing the edge 
detail. 

11. Use the Original and Preview tabs to switch be-
tween your original image and your Simplified image 
to see the difference.  You can also use your spacebar 
shortcut key to do this as well. 

If you want to make some additional adjustments you 
may do so by continuing your work with the sliders. If 

Before Topaz Simplify

After Topaz Simplify
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Before Topaz Simplify
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Workflow

After Topaz Simplify
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2. Create a duplicate layer of your image.  Right-click 
on your image layer in your layers and select “Dupli-
cate Layer”.  You can also achieve this by selecting 
your image layer and dragging it down to the new 
layer icon. 

3. To begin working on your image go to Filters -> 
Topaz Labs -> Simplify 4. 

Sample Project #2
In this project, we will walk you through a second Sim-
plify workflow  to show you how easy it is to instantly 
turn your digital image into a work of art. 

                                                                                    

We will be using this photo of the beach for our ex-
ample.  In the following steps, we will show you how 
to achieve optimal results with your own photos, fol-
lowing this model.  Let’s get started.

Workflow

Please visit the Topaz Simplify website at http://www.to-
pazlabs.com/simplify for video tutorials, tips, and tricks!

Before Topaz Simplify

After Topaz Simplify
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through the panel on the left side of the screen.  To 
select it, just click on it and the sliders will automati-
cally adjust to the pre-defined settings and param-
eters. 

For this example we will be starting with the Painting 
IV preset and manipulating the sliders from there.

Once your image loads,  use the zoom tools to zoom 
in on a specific part of your image.  Then you can click 
on the preview and drag it around until you find an 
area that you like. 

We want to take this image into a more creative and 
artistic direction, so we will begin working with the 
default presets and then move to the sliders, but you 
can start any way you like.

Work Flow
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a single selection will give you optimal image results. 

If you are satisfied with the preset adjustments then 
you can click “OK” to process your image and save it 
back to Photoshop.

If you would like to make some additional adjust-
ments to your enhancement settings then you can 
do so by adjusting any of the sliders in the three tabs 
manually until you achieve your preferred image re-
sults. In this example we will make additional adjust-
ments to the Global Adjustment Sliders.

Work Flow
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to the Adjust tab. 

8. The Adjust tab gives you control over the color, 
contrast and brightness of your image.  

9. Slowly adjust each of the sliders to perfect the 
color in your image.  For this image we will slightly 
increase the Saturation and Saturation Boost sliders.

When you are happy with the color settings, move to 
the Edges tab. 

6. Start in the Simplify tab. It is a good idea to begin 
here, and then progress to the Adjust and Edges tabs 
in order to see the effects of your adjustments easily. 

7. Slowly adjust each of the sliders to create the opti-
mal exposure in your image.  

Work Flow

Visit the Topaz Simplify image gallery to checkout over 
200 user-submitted Simplify images. 

Visit: http://gallery.topazlabs.com/keyword/simplify
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Workflow
The Edges tab is where you can really see the objects in 
your image pop by enhancing or minimizing the edges in 
your image. 

11. Use the Original and Preview tabs to switch be-
tween your original image and your Simplified image 
to see the difference.  You can also use your spacebar 
shortcut key to do this as well. 

If you want to make some additional adjustments you 
may do so by continuing your work with the sliders. 

If you are happy with the new artistic look of your
image then you are ready to process your changes. 

11. Click OK and watch your image transform into a 
beautiful artistic masterpiece. 

Before Topaz Simplify

After Topaz Simplify
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Before Topaz Simplify
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After Topaz Simplify
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Glossary
Color Profile - defines the range of colors that can ap-
pear in a digital photo.

Desaturate - Decreasing the intensity of a color (hue).

Download - The process of transmitting or transfer-
ring data from one device to another.

Export - Outbound data transfer in a format that can 
be used by other programs.

Import - Inbound data transfer into a file or docu-
ment.

Pan and Zoom - A useful function that allows users to 
magnify the captured image in the preview and then, 
by using the cursor, to move or pan around the image. 
Typically Pan and Zoom allows users to magnify the 
image 2x or 4x time.  By magnifying the images and 
zeroing in on a specific section, you can see details 
not visible when the entire image is sized to fit the 
preview.

Parameter - A numerical or other measurable factor 
forming one of a set that defines a system or sets the 
conditions of its operation.

Photo-editing or Imaging software – Programs in 
which you can alter your photos and / or create digital 
images.  Depending on the software, you can improve 
exposure, color and other attributes of your picture, 
paint on it, add type, apply special effects, remove 
noise, resize it, combine it with other pictures, pre-
pare it for e-mail or posting on the web, output it to a 
printer, or do any number of other manipulations or 
edits.

Achromatic - Without color.

Adjustment Layer – A layer that allows you to adjust the 
look of an original image with out making it permanent. 
With adjustment layers you can make various changes to 
a layer without damaging it and go back and readjust it at 
anytime.

Algorithm - Any bit of code or programming that de- 
fines a process.

Brightness - The degree to which a color sample ap-
pears to reflect light. 

Chroma - Purity or intensity of color.  The difference 
of a color against the brightness of another color that 
appears white under similar viewing conditions.

CMYK - Cyan, magenta, yellow, and black. A color 
model commonly used for 4-color printing by printers 
to define and mix all of the colors they are capable of 
outputting.

Color - The human perceptual response to different 
wavelengths of light impinging on the photo recep-
tors in the retina.

Color channel - The visual component of a color digi-
tal image that represents all the pixels in that picture 
made up of a specific primary color.  In a typical digital 
photo, the primary colors of red, green and blue 
(from the RGB color model) create all the colors in 
that photo, which may be represented by three color 
channels, each of red, green or blue.
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Glossary
Plug-in - A computing feature with the ability to be 
added to a system to give extra features or functions.

Preset - A pre-defined combination of parameters and 
settings that is saved into a folder within Topaz Detail 
2.  Topaz provides default presets.  A preview of each 
preset can be seen in the preset preview window lo-
cated at the top left hand side of the interface above 
the preset list. 

Preview- Shows the processed preview of the image.

RAW image - An image file format that contains un- 
touched, “raw” pixel information straight from the 
digital camera’s sensor.  It has yet to translate the in-
formation in each pixel into the full color information, 
so this format offers more control over how the final 
JPEG or TIFF image is generated. 

Refine – Improve (something) by making small changes to 
make it more subtle and accurate. 

RGB - Red, Green, Blue.  The color model that is used 
in digital cameras and by computer monitors.

Saturation - The difference of intensity within a spe-
cific hue.

Shadow - A dark area or shape produced by a body 
coming between the rays of light and a surface.

Sharpness - The clarity of detail in a photo.

Smoothing - To make a surface more regular or con- 
sistent; free from perceptible projections, lumps, or 
indentations.

Before Topaz Simplify

After Topaz Simplify
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software?”
The only limit on the trial versions of the Topaz plug-ins 
is time.  The free trial versions are designed to enable 
you to experience the full functionality of our plug-ins 
for a 30-day trial period.  After the trial period is up, you 
will only be able to use the Topaz software by purchas-
ing it.  You will then receive a license key to activate the 
plug-in, and the trial version will automatically become 
the full version with no time limitations.          

“If I use the 30-day trial version will I need to uninstall 
the trial version before I upgrade to a full version?”
No, the Topaz trial software is designed to be unlocked 
to become the full version simply by entering a license 
key.  The full license key will be e-mailed to you immedi-
ately after you purchase the software.

“Where do I enter my key?”
To enter your key please open an image in Photoshop 
and go to Filter -> Topaz Labs -> Simplify 3 -> Menu -> 
Enter Key.  You can then copy & paste or type in your 
license key and then select OK.

“I had Topaz Simplify as a trial, then I purchased. How 
do I enter my new license key?”
You can enter your new license key by opening up an 
image in Photoshop and go to Filter -> Topaz Labs -> 
Simplify 3 -> Menu -> Enter Key.  Please remove the trial 
key and enter your new purchased license key, then 
select OK and you are all set. 

“I need a Topaz Simplify trial key.” 
Visit http://www.topazlabs.com/trials for a trial key.  
Please check your Spam folder because your Spam 
filter sometimes filters out the automated email. 

If you need more time to evaluate, please e-mail us at 
www.topazlabs.com/support for an extended trial key. 
 

 “How do I check for updates in Simplify” 
You will first open Topaz Simplify and go to Menu and 
then click ‘Check for Updates’. That will launch your 
Topaz Software Manager. The 3rd option down will al-
low you to run an installation for any new updates that 
are avaliable.

“Do you have any other Simplify tutorials?”
Yes, please see pages 26 and 33 of this Topaz Simplify 
user guide, and also visit: http://www.topazlabs.com/
tutorials/simplify

“I do not have Photoshop.  Will  Simplify work with 
my Elements, Aperture, Lightroom, iPhoto Paint Shop 
Pro, Photo Impact or Irfanview?”
Yes, you can use Topaz Simplify with any of the above 
host programs. However, to use Simplify in Aperture, 
Lightroom or iPhoto, you will need usethe free Topaz 
Fusion Express plug-in which will download automati-
cally with Simplify 4.  For more information please visit: 
www.topazlabs.com/fusion

Frequently Asked Questions
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Frequently Asked Questions
“My Topaz Simplify key doesn’t work!”
There are a couple of reasons why Topaz Simplify might 
think your key is invalid.

First, make sure that your key is in the proper format. 
It’ll be in the format “xxxxxx-xxxxxx-xxxxxx-xxxxxx-
xxxxxx” and will be all numbers in 30 digits in five 
groups of six (no letters). 

Second, make sure that as you’re entering the key 
there is nothing in the space beforehand.  This means 
clicking, pressing Ctrl-A, and hitting delete to make sure 
that absolutely nothing is in that field before you paste 
in the key.

If it doesn’t work when you copy and paste, try typing 
it out, and vice versa.

My Topaz filters are grayed out in the filter menu. 
Please make sure that you are using a 8-bit or 16-bit 
image that is in RGB color mode.  Also, if your project 
includes adjustment layers please make sure that you 
are not on an adjustment layer.  You will need to select 
the image layer.  This will allow you to access your To-
paz programs. 

I have a question not listed here. 
Please visit our customer support page online at: 
http://www.topazlabs.com/support



49

User Manual
To

pa
z 

 S
im

pl
ify

Shortcut Keys
Topaz Simplify uses some shortcut keys to speed up your workflow. Many of these 
keys are similar to those in Photoshop. The following keys work at all times.  

Mac  and PC Shortcuts are the same unless indicated otherwise. 

S					          	 Expands / Collapses Simplify Tab
A						      Expands / Collapses Adjust Tab
E						      Expands / Collapses Edges Tab
S					          	 Takes a Snapshot
CMD-Shift-P		   CTRL-Shift-P   	 Recalls previous Snapshot
CMD-Shift-N		   CTRL-Shift-N		 Recalls next Snapshot
CMD-1			   CTRL-1		  View Original Image
CMD-2			   CTRL-2		  View Adjusted Image
Left or Right Arrow Key		      	 Scrolls through presets
Return (enter) key			        	 Applies selected preset
[ key 					          	 Reduces selected slider value by 0.1
] key					          	 Increases selected slider value by 0.1
Home Key 				         	 Set the slider value to minimum
End Key			       	      	 Set the slider value to maximum
Double-click slider name		       	 Resets the slider to it’s default value

Spacebar		       Spacebar	      	 View Original Image	
CMD-ALT-R		    CTRL-ALT-R      	 Reset All	
Zoom to Fit		  CMD-0		   CTRL-0
Zoom to 100%	 CMD-ALT-0		  CTRL-ALT-0
+ or CMD - +		    + or CTRL - +     	 Zoom In	
- or CMD - - 		  - or CTRL - -          	 Zoom Out			              
CMD -Z 		    Ctrl - Z	      	 Undo				               
CMD - Shift - Z	   Ctrl - Shift - Z    	 Redo				              		

MAC Shortcut 	      PC Shortcut 	      Action
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Connect with Topaz

Follow us on Twitter for notifications of 
recent news and easily get in touch with us 

whenever you feel like it!

Find us on our Facebook page and network 
with other Topaz users!

Participate in the entirely user-led Topaz 
Flickr group for a helpful and highly active 
community for Topaz Photoshop plug-ins!

Subscribe to our YouTube channel to keep 
up with any newly released product video 

tutorials!

Check out our new Forum and our blog for 
tutorials, tips and updates from Topaz Labs!



51

User Manual
To

pa
z 

 S
im

pl
ify

Topaz Labs LLC, a privately owned company in Dallas, Texas, focuses on developing advanced video and image enhance-
ment technology. With today’s widespread use of digital still cameras, digital video cameras, and HDTV, the need for high-
quality digital images and videos has greatly increased. Topaz Labs’ mission is to bring practical state-of-the-art image and 
video enhancement technology to both professionals and consumers.

Contact Information
	

Topaz Labs LLC
4100 Spring Valley Road
Suite 103 East
Dallas, TX 75244

Technical Support
Visit: http://topazlabs.com/support/

Copyright © 2012 Topaz Labs, LLC. All rights reserved. http://www.topazlabs.com
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Image Plug-ins				  

Go to http://www.topazlabs.com/trials to get your 30-day free trial!

Ultimate control over 
image exposure, detail, 
and color gives you the 
power to make your 
photos pop.

Specializes in creat-
ing crisp and stylized 
images. Also features 
extensive smoothing 
capabilities. 

Advanced noise reduc-
tion filters noise while 
maximizing and retain-
ing image detail simply 
and effortlessly.

Takes any of your 
regular photos and ef-
fortlessly turn them into 
beautiful works of art.

Specializes in overall 
image improvement. 
Features sharpening, re-
constructing, enlarging, 
high-quality noise 
removal and JPEG arti-
fact damage tools. 

Increase video quality with this suite 
of video enhancement filters utilizing 
super-resolution technology. 

Advanced JPEG artifact 
reduction filters elimi-
nate JPEG compression 
artifacts while preserv-
ing image detail like 
never before. 

Video Plug-ins	

3 levels of intricate and 
specific detail enhance-
ment for naturally 
enhanced images with 
no halos. 

Bring the power of 
Topaz to your Aperture, 
iPhoto and Lightoom 
workflow with the new 
Fusion Express plug-in.

Remove unwanted 
backgrounds from your 
digital images quickly 
and easily with the new 
Topaz ReMask. 

Easily and efficiently capture video 
frames and significantly increase their 
quality and resolution with this stand-
alone Windows application. 


